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These release notes highlight new functionality, enhancements, software and hardware dependencies, and
include upgrade instructions for the NetVanta Unified Communications product family. This document is to be
used in conjunction with product documentation and training for the preparation of new and existing software
installations and is intended for technical professionals who are providing support services for NetVanta Unified
Communications products.

For general product information, please visit ADTRAN's website at http://www.adtran.com.

CAUTION: ltis strongly recommended that the contents of this document be reviewed before any
installation or upgrade, no matter how familiar the installer is with the product, to ensure that
current installation and upgrade procedures are followed. These procedures could change from
release to release, including maintenance releases. Failure to follow the upgrade procedures in this
document could result in non-operational systems.

1 Summary of Changes

This section summarizes new functionality introduced in this NetVanta UC Server release, along with issues
resolved in each release and any release-specific actions that are required as part of upgrading. Each maintenance
release is identified separately. More detailed descriptions for major new functionality follow in Section 2 New
Functionality Details,. Internal tracking numbers are noted (for example, [12341).

For newly introduced functionality and issues resolved in previous major releases, please consult the release notes
or product documentation for the respective releases.

Where functionality or issues resolved do not apply to products in the product family, the applicable products are
noted (for example, [ECS, BAS, UCS)).

NOTE: Be sure to review all upgrade actions for all releases between your current release and the release and
your upgrade. Subsections of the sections below identify required actions, including information about client
upgrades.

1.1 Releases.2.0

Release 5.2.0 is a release update of NetVanta UC Server version 5.1.x which extends existing functionality
including support for Exchange Web Services (EWS) which greatly improves Exchange integration, reliability and
interoperability while minimizing MAPI future dependencies. It also adds improved software exception handling
and reporting mechanisms as well as continued French language support including user defined language settings
and French language TTS (Text To Speech) capabilities.

This release also extends handset features including Park Zone BLF, HFAA (hands-free auto-answer), VLAN
filtering support for Polycom family handsets including both legacy 3.8 and 4.x firmware updates. Additional
improvements include the integrated installations of both Business Continuity and UCNS software which
simplifies deployments of these extended product features.

Additional interoperation with ADTRAN products namely the NetVanta 7100, the TAgxx series and SBC Feature

Packs are now also supported. [ECS, BAS, UCS
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2 New Functionality Details

This section describes the new functionality introduced in this NetVanta UC Server release. Where functionality
or issues resolved do not apply to products in the product family, the applicable products are noted.

2.1 Release 5.2.x

NetVanta UC Server Release 5.2.0 is a minor release which incorporates all existing features and functionality of
past NetVanta UC Server releases combined with the introduction of the following features:

EWS Exchange Support

Exchange Web Services (EWS) provides the functionality to enable client applications to communicate with the
Exchange server. EWS provides access to much of the same data that is made available through Microsoft Office
Outlook. Support for EWS has been included in this latest release to leverage this newer APl and to reduce
Microsoft MAPI dependencies in the future. This integration also provide future support for hosted Exchange
environments as well as support for existing premise based Exchange server including 2007 and 2010.

Hands free Auto-Announce (HFAA)

This PBX feature provides an access code (SPRE) that invokes a call to a destination SIP Telephone for the
purposes of phone auto answers and bi-directional audio support. SIP phones which support the ALERT-INFO
header with this auto answer method will be able to support this feature. All supported phones that are able to

use the paging server will support this feature. |ECS BCS

BLF Park Zones

This enhancement adds visual appearances of a park position on applicable SIP phone buttons. Calls can be
parked or un-parked via this button and provide a visual indicator for the user. Management of this feature is
accessed through the Phones configuration section located via the Admin client. SPRE codes are also supported

as well as LED light indicator where possible on the handset. |ECS BCS

Exception Handling and reporting

The UC Server system includes an improved mechanism for the diagnostic management, delivery and log details
of system problems, failures and exceptions for troubleshooting and debugging purposes. General
Administration Logs now include additional details for reporting and additional settings are now available through
the Options settings including report details and attachment delivery management.
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French Language User Defined and TTS support

The latest French Language feature enhancement now includes user defined language settings and adds French
voice TTS (text to speech) support. Administrators can now independently set languages for each user as well as
define the voice engine used for user TTS capabilities. A general system defined menu of TTS voices is located in
the Administrative Options of the UC client to allow for more simplified audio language selection and
configuration.

Polycom phone VLAN filtering and Firmware support

The latest Polycom 4.x/3.8 firmware releases for both legacy and newer handset revisions are now included in the
product. This release additionally supports VLAN filtering as per Polycom configuration file settings. This latest
release includes these provisioning firmware loads along with its menu inclusion via the UC Server’s Phones

management section. ECS only|

UCNS Email notification

The UCNS client and server services are now installed automatically with this release to ease the deployment and
configuration of the UC notification server feature. The current UCNS feature has the ability to send "Notification
Summary Reports" as an email, to one or multiple designated system-wide email addresses upon the completion
of each "Job". This latest feature improvement now allows you to specify the email addresses for each report on
basis of individual job definitions. Refer to the appropriate technical note for information on UCNS configuration.
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Software fixes included in release 5.2.x since 5.1.x

Tracking# Summary

UCS-569 No user feedback when the service mailbox is not connected UC to Exchange

UCS-685 Caller should receive a better prompt if the page operation (or in the future if the HFAA operation)
fails when the file is not found or cannot be loaded (instead of prompt-480)

UCS-651 SIPPBX\version.bat file has wrong path to the java.exe file

UCS-770 ApplicationServerApi.dll is not signed

UCS-445 UC Client writes "DefaultServer" value to registry even when login to the selected server fails
UCS-759 Servicemgr transition to connecting hold or connecting offhold not defined (inbound caller to

queue appears connected but no audio)

UCS-591 The administrator can not update the Exchange server location (without manipulating users
message store manually)

UCS-558 When Exchange server version does not match configured version, log not only the version found
but the version selected/configured as well

UCS-862 Exception in ServerToServerService - (GetUserPhoneNumbers) Exception Message: Object
reference not set to an instance of an object (if unable to find pbxid)

UCS-765 Default email address for Exception Reports should not be ucserver@adtran.com

UCS-557 Status column for the Exchange server object in the admin client Servers pane appears blank
(when the detected version of the Exchange server is greater than current config)

UCS-664 Time improvements needed for setting up UC Trust relationship - can take up to 5 minutes to
receive invite or to receive the Accept

UCS-616 PBX sends 180 with SDP causing local ringback to fail
UCS-936 Faulty logic with time match on DR service
UCS-627 After connected Exchange server object upgraded (from 5.0.1) the connection state unexpectedly

indicates "Connected. Warning Exchange Server Version does not match." (version unknown)

UCS-664 Time improvements needed for setting up UC Trust relationship

UCS-612 Federated trusted servers remains in disconnected state after network is unavailable for extended
period

UCS-591 The administrator cannot update the Exchange server location

UCS-635 The previous id is unexpectedly being used for connection to the remote server (even though

RosterServer id appears to be updated in the database). ucCompanion search does not return
results even though servers trusted.

Note that all fixes from previous 4.x releases up to and including 4.6.x will also be included in release 5.2. Please
consult the specific 4.x /4.6.x/5.x release notes for details on issues resolved in those releases.
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2.1.1 Upgrade Requirements

Prior to upgrading an existing NetVanta UC Server system, be sure that the hardware platform and operating
system software meet the minimum requirements; otherwise, you will not be able to upgrade the software.
Ensure that both client and server requirements are met. Refer to Section System Requirement 3.2 for
information.

CAUTION: Failure to preserve installed software release media properly could result in the inability
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily
available from ADTRAN Technical Support or your reseller causing delays to support technicians
rebuilding failed servers.

2.1.2  Client Upgrade Actions

Client software MUST be upgraded for all users of the NetVanta UC Server system. More information on client
deployment techniques, including automated deployment can be found in Section 4.3, Installing or Upgrading
NetVanta UC Client Software.

2.1.3  Other Upgrade Actions

If the administrator has customized any of the system audio files (Data\System\CustomAnnouncements) and
not placed them in the custom announcements folder Data\System\CustomAnnouncements\English
(U.S.) Male, then the customized files MUST be copied from CustomAnnouncements.Backup folder.

CAUTION: Failure to copy or backup customized audio files will cause them to be overwritten
during the upgrade. Only audio file from this location (Data\System\CustomAnnouncements) will
be automatically copied to CustomAnnouncements.Backup during upgrades.

For upgrades of the ECS and BAS products, scripts MUST be run before and after upgrading to properly upgrade
phone configuration files. Any customizations to phone configuration files must be manually re-applied using the
information and backups made by the scripts. Refer to Section 4.2.2, Upgrading NetVanta UC Server from any 4.x.x
Release, for more information on this procedure.

CAUTION: The SQL database instance for NetVanta UC Server MUST be backed up to ensure
proper recovery of failed systems. For instructions on backup and restore procedures, refer to the
Planning and Deployment Guide, available online at https://supportforums.adtran.com. Please
adjust backup procedures accordingly. Failure to do so could result in data loss or extended system
outages in the case of hardware or software failures.

Please note that any upgrade from 4.x to 5..x UC releases will convert the existing SQL 2005
database instance named Objectworld to an SQL 2008 instance named NetVantaUC. You will
need to adjust any existing backup script to support this instance name change already put in place
as part of a scheduled backup maintenance routine .
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3 Installation Requirements

This section describes the environmental prerequisites required for the correct operation of NetVanta UC Server,
including operating systems, server/client platforms, messaging servers, and mail clients. In addition, it describes
any steps required prior to installing NetVanta UC Server software, including obtaining the license key.

3.1 Preserving Installation and Upgrade Media

If physical installation media (a CD or DVD) was received, please store this media in a safe place so that the
software can be reinstalled at a later date if necessary (for example, in the event of a hardware failure).

If the software was downloaded, please ensure that a separate copy of the installation media is made to CD or
DVD and this media is stored in a safe place so that the software can be reinstalled at a later date if necessary (for
example, in the event of a hardware failure). Do not store the downloaded media on the same physical disks as
the operational server as a single disk failure could cause this media to be permanently lost.

Ensure that if software upgrades are performed, new versions are also stored on separate media in a safe place.
Support personal could require a copy of the installation media to reinstall software at a later date.

CAUTION: Failure to preserve installed software release media properly could result in the inability
to rebuild a failed server at a later date. Copies of noncurrent software versions might not be readily
available from ADTRAN Technical Support or your reseller causing delays to support technicians
rebuilding failed servers.

3.2 System Requirements

3.2.12  Server Components

This section describes the required operating systems, hardware requirements, and third-party integration
platforms for the NetVanta UC Server server components. This applies to both upgrades and new installations. If
existing server hardware does not meet these requirements, it must be upgraded or migrated to new hardware
prior to upgrading to this release of NetVanta UC Server.

3.2.1.1  Operating Systems
The NetVanta UC Server server components support the following Operating Systems:

Microsoft® Windows™

e  Microsoft Windows Server 2008 R2 (x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.

e  Microsoft Windows Small Business Server 2008 (x64)

The recommended deployment for optimal performance and reliability is to install NetVanta UC
Server on the additional Windows Server 2008 license that is part of the Premium Edition of
Windows Small Business Server 2008. NetVanta UC Server can also be installed on the Windows
Small Business Server 2008 platform with suitable hardware. Refer to Section 3.2.1.3, Hardware
Requirements, for more information.

e  Microsoft Windows Server 2008 (x86, x64)
o Foundation, Standard, Enterprise, and Data Center editions are supported.
o Deployment on Server Core or Hyper-V is not supported.
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e  Microsoft Windows Server 2003 R2 SP1, SP2 (x86)
e  Microsoft Windows Server 2003 SP1, SP2 (x86)
e  Microsoft Windows Small Business Server 2003 SP1 (x86)

VMware vSphere™

e VMware vSphere 4.1
e VMware vSphere 5.0

3.2.1.2 Deprecated Operating Systems (no longer supported as of 5.0.x)
e  Microsoft Windows XP SP2, SP3 (Professional) (x86)
e  Microsoft Windows Essential Business Server 2008 (x86, x64)
e  Microsoft Windows Small Business Server 2011 (x86, x64)

Other software platforms are not supported.

Installation of the server components into other virtualization environments (Virtual Server, Hyper-V, Virtual PC,
Virtual Box, etc.) is not supported in production deployments. Due to the real-time nature of
telecommunications, audio problems may be experienced in these environments. ADTRAN recommends using
server operating system only for all installations of NetVanta UC Server.

CAUTION: When using TAPI integrations, or other integrations requiring use of CTl drivers, please
review driver documentation for those products BEFORE proceeding with plans to use Windows
Server 2008 or Windows Server 2008 derived platforms (SBS 2008/2010) as the server platform for
those deployments.

3.2.12.3 Hardware Requirements

To install NetVanta UC Server, the server hardware platform must meet the minimum requirements in the
following table. The minimum requirements are for a minimal installation. The recommended requirements are a
guideline for more robust, reliable, and future-proofed systems.

Product engineering guidelines and recommendations should be consulted and followed for anything other than a
minimal installation (for example, installations with more than 25 users). Sizing of the server hardware is
dependent on the number of users, the traffic levels, and application services used. Selection of hardware should
also take into account such things as redundant power supplies, uninterruptable power supplies (UPSs), and
redundant disk arrays (for example, RAID) so that the end users’ needs and expectations are met, along with any
future growth requirements.

Consult TN202 - Hardware Platform Recommendations and the Planning and Deployment Guide, available online at
https://supportforums.adtran.com, for more information on correctly selecting the hardware.

Hardware Minimum Recommended

Component

Processor Intel Pentium Dual-Core (E2140) Intel Xeon Quad-Core (E5310)

RAM 4 GB 4 GB
4 GB on Windows Small Business Server 2003 6 GB on Windows Small Business Server 2008
6 GB on Windows Small Business Server 2008
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Hardware Minimum Recommended
Component
Disk space 80 GB (usable space) 146 GB (usable space)
7200 RPM SAS—-RAID10orRAID 5
3.2.2  Mail/Messaging Servers for Unified Messaging

NetVanta UC Server supports the following email servers for Unified Messaging:

Microsoft Exchange™ Server 2000, 2003 SP1 (requires service pack 1 or later), 2007**, 2010, SP1/Sp2 **

WARNING: ** Changes in the Exchange Mailbox detection logic for connecting to Microsoft
Exchange Server 2010 or 2007 when the Exchange Mailbox, Client Access, and Hub Transport do not
reside on the same server may require disconnecting and re-connecting the mailbox to ensure
proper connectivity to the server in this configuration after an upgrade.

IBM® Domino™ Server 6.0.x, 6.5.%, 7.0, 8.0 (via IMAP)

Google Mail (via IMAP using stunnel)

University of Washington IMAPd

Any 100 percent compliant IMAP4revi (RFC 3501) message store (different servers could require different
query optimization techniques — consult product documentation for query optimization technique
determination procedures)

Integration with Microsoft Exchange Server requires a MAPI connector to be installed on the NetVanta UC Server
platform. The supported MAPI connectors, of which only one should be installed on the server platform, are the

following:

Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1

(Version: equal or greater than 6.5.8165.0, 2010-Apr-28 — older versions are not compatible with all
platforms).This is available for download free of charge from:

http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-

0a110307611e&displaylang=en

Microsoft Outlook™ 2003 SP3 only

CAUTION: Microsoft Outlook 2003 as a MAPI connector is not supported and will cause unreliable
integration with Microsoft Exchange Server 2010 and could cause system outages.

Microsoft Outlook 2007 SP1 only

CAUTION: Outlook 2007 SP2 is not compatible as a server MAPI connector with UC Server and
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server.

All Microsoft Exchange 2010 integrations are only supported with MAPI Client and Collaboration
Data Objects 1.2.1

CAUTION: Outlook 2010 is not compatible as a server MAPI connector with UC Server and
installing it will cause NetVanta UC Server to be unable to connect to Exchange Server.



http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=e17e7f31-079a-43a9-bff2-0a110307611e&displaylang=en

NetVanta Unified Communications

ADTRAN recommends using Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 instead
of Microsoft Outlook and strongly encourages all customers to switch to this MAPI connector instead of Outlook.
The benefits of doing this are as follows:

e No Outlook license is required for the NetVanta UC Server system. The MAPI/CDO package is available
at no charge.

e The MAPI/CDO package is a minimal installation that requires fewer Microsoft Updates.

e This component is designed and provided by Microsoft explicitly for the purpose of allowing applications
such as NetVanta UC Server to access Exchange Server and does not include many of the client-side
nuances of Outlook versions of MAPI.

On Exchange Server 2003, additional steps are required after following the manual integration instructions in
Appendix A of the Configuration Guide:

Delegate Exchange View-Only Administrators control to the NetVanta UC Server service account:

Open Exchange System Manager on an Exchange Server in the enterprise, or an administrative workstation.
Select the enterprise level object (the root object in the tree).

Select Delegate control... from the Action menu. This will open the Exchange Administration Delegation
Wizard.

Click Next.

In the Users or Groups page of the wizard, click Add to open the Delegate Control dialog box.

Select the role Exchange View Only Administrators from the list of roles.

Click Browse... and select the service account used by NetVanta UC Server for Exchange Server and network
integration.

8. Click OK in the Select Users, Computers or Groups dialog box.

9. Click OKinthe Delegate Control dialog box.

10. Click Next in the Users or Groups page of the Exchange Administration Delegation Wizard.

11. Click Finish to complete and close the wizard.

w N P

N ov s

3.2.3 Client Components

This section describes the required operating systems and hardware requirements for the NetVanta UC Server
client components. Most installations will deploy client software to some or all of the end users of the system.
Some installations do not require deployment of the client software depending on how NetVanta UC Server will
be used.

3.2.3.1  Operating Systems
The NetVanta UC Server client components (NetVanta UC Client, NetVanta ucCompanion, and NetVanta
ucCompanion - Live Attendant) support the following Microsoft® Windows™ Operating Systems:

e  Microsoft Windows 7 (Professional, Ultimate, or Enterprise Editions) (x86, x64)

e  Microsoft Windows Vista, SP1, SP2 (Business, Ultimate, or Enterprise Editions) (x86, x64)
e  Microsoft Windows XP SP2, SP3 (Professional or Tablet PC Editions) (x86)

e  Microsoft Windows Server 2008 R2 (x64)

e  Microsoft Windows Server 2008 (x86, x64)

e  Microsoft Windows Server 2003 R2, SP2 (x86)

e  Microsoft Windows Server 2003 SP1, SP2 (x86)

Other software platforms are not supported.
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3.2.3.2  Prerequisite Components
Client components now requires a minimum version of Microsoft .NET Framework 4.0 to be installed on target

systems. In addition, for some components additional Microsoft redistributable components will be installed by
the client installer.

3.2.3.3 Hardware Requirements
To install NetVanta UC client, the platform must meet the following minimum requirements for the specified
Microsoft Windows operating systems listed below.

Client XP, Server 2003 Vista, Windows 7, Server 2008,
Server 2008 R2

Processor x86 compatible processor x86 or x64 compatible processor
600 MHz or higher 1GHz

RAM 1GB 1GB

Free Disk space 500 MB 500 MB

Video Super VGA (800 x 600) or higher Support for DirectX g graphics with:
resolution video adapter and monitor e \WDDM Driver

e Minimum 128 MB graphics
memory

e Pixel Shader 2.0 in hardware

e 32 bits per pixel

3.2.3.4 Email Clients for Unified Messaging
NetVanta UC Client integrates with the following email clients for Unified Messaging:

e  Microsoft Outlook 2002/XP, 2003 SP3, 2007 and 2010 (x86)
e  Microsoft Outlook 2010 64 bit without UC voice/fax form client support
e |IBM Lotus Notes™ 6.0x, 6.5.%, 7.0, 8.0

3.3 Product Licensing (License Key)

All NetVanta UC Server products must be correctly licensed to operate. The license key obtained from ADTRAN is
specific to each installation and defines the exact functionality licensed by the end user for their installation.

3.3.1  New Installs

When installing NetVanta UC Server for the first time, you must obtain a license key to install and activate the
software.

3.3.2 Upgrades

To upgrade NetVanta UC Server from a previous major or minor release, you must obtain a new license key prior
to beginning the upgrade. The existing license key, found in the License Information dialog box in the
administrative NetVanta UC Client must be updated to the new license key prior to beginning the upgrade. After
the new key is installed, you can continue to upgrade the server software. You do not need a new license key for
maintenance (patch or dot) releases.

Upgrade license keys are only available to customers who have an active Software Assurance subscription.
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3.3.3 Obtaining a New License Key

To obtain a new or upgrade a license key, fill out a license key request in the UC Tools area of the ADTRAN
website (http://www.adtran.com/uctools).

Note: Please allow enough time to obtain the license key — at least one (1) business day should be allocated to
ensure the license key is obtained before installation or upgrade.

You will need the following information:

1. Contact information
Product Keys
e New installs: available from materials that shipped with the product.
e Upgrades: available for a user with Administrator privileges. From NetVanta UC Client, select the Help
menu > License Information.
3. Purchase key
¢ New installs: available from materials that shipped with the product.
e Upgrades are available:
e  Forauser with Administration privileges: From within NetVanta UC Client, select the Help > License
Information. Click Modify license.
e  From the Product Licensing Wizard dialog box from Step 1 of NetVanta UC Server Configuration
Wizard.
4. Machine ID
e New installs: available from the Product Licensing Wizard dialog box of Step 1 of the NetVanta UC Server
Configuration Wizard.
e Upgrades are available:
e Forauser with Administration privileges: From NetVanta UC Client, select the Help > License
Information. Click Modify license.
e  From the Product Licensing Wizard dialog box of Step 1 of NetVanta UC Server Configuration
Wizard.
5. Platform specifications (CPU speed, RAM, and server OS) — available from the System control panel in the
Windows Control Panel.
6. Product version and edition you will be installing or upgrading — available from the materials shipped with the
product.
Message store type (Microsoft Exchange Server, Lotus Domino/Notes, IMAP4, or local machine) and version.
8. Legacy PBXinterconnection, if applicable: PBX type, firmware version.

~

3.4 Prerequisite Components

NetVanta UC Server requires that prerequisite components be installed prior to installing the NetVanta UC Server
software. The installer will detect which components are missing from the system and prompt accordingly. Some
of the prerequisite components are included on the distribution media and can be installed automatically by the
installer. However, others must be obtained directly from the vendor. Links to the relevant web-sites for any
components that require downloading will be provided by the installer.

Not all prerequisites are required on all operating systems; specifics are noted below. Except where indicated, the
prerequisites are installed automatically by the installer. The prerequisite components are:

e Microsoft .NET Framework 4.0 (download link provided in installer)
e Windows Server 2008 Enhanced Desktop Feature (a reboot is required after installation) [Windows
Server 2008-based systems only pre-requisite Microsoft Windows Server 2008 Roles and Features]
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*Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1 (Version: 6.5.8165.0,
2010-Apr-28 - older versions are not compatible with all platforms

Microsoft Visual C++ 2005 SP1 Redistributable Package (x86/x64)

Microsoft Visual C++ 2008 SP1 Redistributable Package (x86/x64)

Microsoft SQL Server 2008 Express Edition

ADTRAN Software Diagnostic Logging Tools

*MAPI Client and Collaboration Data Objects pre-requisite used for integration with Exchange.

CAUTION: NetVanta UC Server will only work correctly with the version of Microsoft SQL Server
that is provided on the distribution media. Other instances of SQL Server cannot be used by
NetVanta UC Server.
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4 Installation and Upgrade Instructions

Please review Section 3 Installation Requirements before proceeding with this section. It contains important
information about product licensing, system requirements, and the versions of required external software
components.

CAUTION: Failure to comply with the installation requirements, or properly follow the installation
or upgrade instructions will result in an inoperable or poorly performing system.

4.1 New Install of NetVanta UC Server

This section contains an overview of the installation for NetVanta UC Server; for detailed installation procedures
consult the Installation Guide applicable to your NetVanta Unified Communications product. To facilitate
installation and configuration, have the following reference material available during installation:

e Release Notes (this document)

e  Planning and Deployment Guide

e Installation Guide

e NetVanta Unified Communications Server Presence and Control Components Guide (for use with NetVanta
ucCompanion - Live Attendant)

e Configuration Guide

e Administrator Manual

e  NetVanta ucCompanion Desktop Presence User Guide

To ensure that all the required information is available during the installation and configuration process, it is
recommended that the Planning and Deployment Guide Worksheet be completed.

4.1.1  Installing the Server Software

The installation software will automatically verify the prerequisites for software installation. Make sure that you
run the installation from a Windows logon that has the ability to install software on the NetVanta UC Server
system (for example, Administrator privileges).

To install NetVanta UC Server:

1. Ifthe NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the
NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on NetVanta UC Server (you
will need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear).

b. Insertthe NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN
NetVanta Unified Communications CD menu will appear.

Install the applications to the NetVanta UC Server platform by clicking on the Install Server button on the
installation screen and following the prompts on the subsequent screens.

a. Ensure that all prerequisites are installed. These will vary depending upon your platform and the
components purchased, such as the Presence and Control components and the Windows 2003
Server Administration Tool Pack. The NetVanta UC Server Installation Wizard will ensure that all
prerequisite components are installed before proceeding.

b. Afterall the prerequisite components are successfully installed, the wizard allows you to install the
NetVanta UC Server software.

2. Runthe NetVanta UC Server Configuration Wizard, Configure UC Server. The NetVanta UC Server
Configuration Wizard allows you to specify server properties such as message store, NetVanta UC Server
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administrator password, PBX information, and dialing properties. The wizard guides you through the server
configuration process. The wizard does most of the configuration tasks automatically, however, site specific
information about the network and server needs to be entered at various steps.

3.  Wheninstalling NetVanta UC Server for the first time, you must obtain a license key. To obtain a license key,
please refer to Section 3.3, Product Licensing (License Key).

4.1.2 Installing the Client Software

In order for NetVanta UC Server users to take full advantage of its functionality, client software should be
deployed to their desktop or laptop computers. Refer to Section 4.3, Installing or Upgrading NetVanta UC Client
Software, for installation options and procedures.
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4.2 Upgrading/Cross-grading NetVanta UC Server

CAUTION: Backup procedures have changed from previous releases. For instructions on backup

and restore procedures, refer to the Planning and Delpoyment Guide, available online at

https://supportforums.adtran.com, and adjust backup procedures accordingly. Failure to do so could

result in data loss or extended system outages in the case of hardware or software failures.

4.2.1

Upgrade/Cross-grade Matrix

The following table describes which versions of NetVanta UC Server can be upgraded to newer versions and which

versions of CallAttendant Office can be cross-graded to NetVanta UC Server.

To 4.0.X 4.6.x 5.0.X 5.1.X
(UC Server) (NetVanta UC (NetVanta UC (NetVanta UC
Server) Server) Server)
From
Pre 3.2.x Unsupported via Unsupported via Unsupported via Unsupported via

(CallAttendant Office)

direct upgrade —
upgrade to 3.2.x
first, then to 4.0.x

direct upgrade —
upgrade to 3.2.x
first, then to 4.0.x

direct upgrade —
upgrade to 3.2.x
first, then to 4.0.x

direct upgrade —
upgrade to0 3.2.x
first, then to 4.0.x

Post 3.2.x

Unsupported via
direct upgrade —

Unsupported via
direct upgrade —

Unsupported via
direct upgrade —

(CallAttendant Office) v upgrade to 4.0.x upgrade to 4.0.x upgrade to 4.0.x
first first first
4.0.X U.nsupported via U.nsupported via
(CallAttendant Office) J J direct upgrade — direct upgrade -
upgrade to 4.5.x upgrade to 4.5.x
first first
4.2.X Unsupported via Unsupported via
direct de- direct de-—
(CallAttendant Office) v rect upgrade Irect upgrade
upgrade to 4.5.x upgrade to 4.5.x
first first
4.0.X Unsupported via Unsupported via
(UC Server) J direct upgrade — direct upgrade —
upgrade to 4.5.x upgrade to 4.5.x
first first
4.1.X Unsupported via Unsupported via
direct upgrade — direct upgrade —
(UC Serven) v upgrade to 4.5.x upgrade to 4.5.x
first first
4.2.X Unsupported via Unsupported via
direct upgrade — direct upgrade —
(UC Server) v upgrade to 4.5.x upgrade to 4.5.x
first first
4.3.X Unsupported via Unsupported via
(UC Server) v direct upgrade — direct upgrade —

upgrade to 4.5.x

upgrade to 4.5.x
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first first
Loy X Unsupported via Unsupported via
direct upgrade — direct upgrade —
(UC Server)
upgrade to 4.5.x upgrade to 4.5.x
first first
4.5.X Unsupported via
direct upgrade —
(NetVanta UC Server) v N upgrade 10 4.6.x
first
.6.x
‘ Y v v
(NetVanta UC Server)
.0.X
° Y Y Y
(NetVanta UC Server)
1.X
> v v v
(NetVanta UC Server)
.2.X
> v v v
(NetVanta UC Server)

In order to upgrade from older versions, interim upgrade steps must be followed. Refer to the applicable section
below for more details.

4.2.2 Upgrading NetVanta UC Server from any 4.x.x Release

CAUTION: The existing version of NetVanta UC Server must NOT be uninstalled prior to
upgrading. The installation process requires that the existing implementation be available in order
to perform the upgrade correctly.

The following is a summary of the upgrade procedure from any NetVanta UC Server 4.x.x release; refer to the
Installation Guide applicable to your NetVanta Unified Communications product, available online at
https://supportforums.adtran.com, for detailed instructions on installing this component.

CAUTION: Failure to follow the steps below, exactly as described, could result in a system that does
not upgrade or operate correctly after upgrade.

Perform the following steps:

1. If performing a major or minor upgrade, obtain a new license key. Please refer to the instructions in Section
3.3, Product Licensing (License Key).

2. Backup the NetVanta UC Server. For instructions on backup and restore procedures, refer to the Planning and
Deployment Guide applicable to your NetVanta Unified Communications product, available online at
https://supportforums.adtran.com. Backing up will preserve the following data:

a. Users (greetings, services, announcements)
b. Port configuration

c. Attendant data

d. System configuration
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Routing data
Telephone data
Gateway data

PBX configuration data

Sa o

CAUTION: Failure to backup the data according to these instructions and the Technical Note will
result in the inability to restore the system to the original configuration should the upgrade process
be unsuccessful or aborted. Always back the system up prior to upgrading.

If a new license key was obtained in Step 1, modify the current license key using the following procedure:

a. Open NetVanta UC Client using the current installed product version and log in as a user with

administrative privileges.

Select License Information... under the Help Menu on the main toolbar.

Click the Modify license... button to open the Modify License dialog box.

Enter the new license key in the space provided.

Click OK to close the Modify License Dialog box.

Click Close to close the License Information Dialog box.

g. Close NetVanta UC Client by clicking the top right corner x icon or selecting Close from the File menu.

If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will
need to provide a location and name for the folder).

b. Insert the NetVanta UC Server CD-ROM. The CAAutoRun application will start, and the ADTRAN
NetVanta Unified Communications CD menu will appear — leave this open for now, you will use it later.

o a0 o

For ECS and BAS product variants, run the Pre-Update.bat script file as follows:

IMPORTANT NOTICE: For upgrades of ADTRAN phone family types, custom configurations
will be lost unless the following changes are made prior to running the Pre-Update.bat

a. Locate the ADTRAN.original.zip on the release media
“Release\Utility\Scripts\ADTRAN.original.zip” or via http://www.adtran.com/support/

b. Extract the zip to the following location: "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\ADTRAN
c. Runthe Pre-update and Post-updates as instructed

a. Click the Start menu and select Run...
b. Type cmd.exe and click OK to open a command prompt window

NOTE: On systems with User Account Control (UAC) enabled, such as Windows Server 2008 R2, you
must start the command prompt window as Administrator. To do this, instead of Step a and Step b
above, do the following:

Click on the Start menu.
Type cmd. exe in the search bar. (If classic start menu is enabled, locate Command Prompt under
All Programs | Accessories instead.)

3. Right click on cmd. exe in search results (or Command Prompt in the menu), and select Run as
administrator.

4. Accept the UAC prompt to elevate the command prompt to administrative privileges.
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c. Navigate to the script folder on the installation media using the cD command. This is located in the
Utility\Scripts subfolder of the installation media.

Example: CD /d C:\NetVantaUCServerInstallMedia\Utility\Scripts
d. Runthe Pre-Update.bat script, supplying any appropriate parameters relevant to your installation:
Syntax: Pre-Update.bat [/V | /?] [PhoneTypes Folder] [Backup Folder]

e If your NetVanta UC Server installation is not located at C: \Program
Files\ADTRAN\NetVanta UC Server), you must specify the location of the PhoneTypes
system data folder as shown in the example below.

o If backups should be written to a location other than C: \Backup\PhoneTypes, then you
must specify a backup folder as shown in the example below.

e The /2 option provides help on the script; the /v option provides more detailed output and
logging.

Example: Pre-Update.bat "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\"

e.  When the script prompts you to continue, confirm the information displayed, type Y, and then press
Enter.

f.  Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Pre-Log.txt in the backup location. The default backup location is C: \Backup\PhoneTypes.

g. Leavethe command window open because it will be used later.

The ADTRAN NetVanta UC Server Application Services service could be unable to be started during the

upgrade due expiry of the service account password. This can also occur spontaneously on some Windows XP

installations or in networks where account passwords have to be changed regularly, but will not be detected

until the machine is restarted or the ADTRAN NetVanta UC Server Application Services service is restarted.

Be sure to have the service account password accessible in order to reset it immediately.

To verify that the service account password has not expired, do the following:

Open the Services administration tool from Start > Control Panel > Administrative Tools.

Locate the service named ADTRAN NetVanta UC Server Application Services.

Right click on the service, and select Restart from the context menu.

If the service fails to start, right click on the service, and select Properties from the content menu.

Select the Log On tab. Re-enter the service account password in the provided fields and click OK.

Attempt to start the service again by right clicking on the service, and selecting Start from the context

menu. If the service again fails to start, verify that the service account is operating correctly and is not

locked out.

S o0 T o

Failure to perform this step will cause the install to fail with a 1920 error if there is a problem with the service
account or its password. This can be corrected by following the same steps while the 1920 error is displayed.
Do not cancel the 1920 error dialog box because it will fail to upgrade and your system will have to be
restored from backups. When you have corrected the service account password, click Retry in the 1920 error
dialog box.

If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Locate the temporary folder where you extracted the files in a previous step. Start the upgrade by double
clicking on CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear).

b. Fromthe ADTRAN NetVanta Unified Communications CD Menu (opened when the CD was inserted in a
previous step), click the Install Server button to prepare the NetVanta UC Server upgrade.
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On an upgrade from previous releases, you could be required to install or update prerequisite components.

Click on the Verify or automatically install remaining components button to proceed. Some components

might require downloading from the vendor’s websites.

Adding the NetVanta UC Server Presence and Control Components:

a. Ifyouare using the NetVanta Unified Communications Server product variant, or if you do not plan on
using NetVanta ucCompanion - Live Attendant:

e  Disable the following option: Install Presence Components.

e  Click Next.

b. If you plan on upgrading the Presence and Control Components from a 4.2.X, 4.3.X, 4.4.X, 4.5.X, 4.6.x or

5.0.x version you must first uninstall the existing version via Add/Remove control panel applet:

e  Navigate to the install media and locate the ADTRAN NetVanta ucCompanion.msi and launch the
installer and follow the dialog box.

e  (lick Install on the ADTRAN NetVanta UC Live Attendant Server Components Setup Wizard
screen.

e  Click Next on the welcome page of the ADTRAN NetVanta UC Live Attendant Server
Components Setup Wizard and follow the prompts on subsequent screens until finished. Consult
the NetVanta Unified Communications Server Presence and Control Components Guide for additional
installation documentation.

e  C(lick Finish when complete.

e  Click Yes when prompted to restart the system for the configuration changes to take effect.

Upgrading the NetVanta UC Server.
a. [Ifupgrading from 4.2.X, 4.3.X, 4.4.X, 4.5.X, 4.6.X, OF 5.X:

e  The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly
as the upgrade does various checks on the system.

e  Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified
Communications Server Setup Wizard appears and follow the prompts to complete the upgrade.

e  Click the Finish button to close the setup wizard and return to the Preparing NetVanta UC Server
Installation dialog box.

b. If upgrading from 4.0.x or 4.1.x Trial:

e Install the server application to the NetVanta UC Server platform by clicking on the Install UC
Server button.

e  The ADTRAN NetVanta Unified Communications Server Setup welcome page will appear briefly
as the upgrade does various system checks.

e  Click the Install button when the page titled Resuming the ADTRAN NetVanta Unified
Communications Server Setup Wizard appears.

e  Continue clicking the prompts to complete the upgrade.

e  Click the Finish button to return to the Preparing UC Server Installation dialog box.

Click the Configure UC Server button to launch the NetVanta UC Server Configuration Wizard.

NOTE: If all the steps in the server configuration were completed prior to the upgrade, you will be presented with
three options (Change Service Account, Users, and Phone Types). You could be required to perform the first
option, Change Service Account to reset the service account to what was configured prior to the upgrade.

In an upgrade from 4.0.x you need to complete Gateway configuration in the NetVanta UC Server

Configuration Wizard then reset the service account:

a. Click onthe Configure UC Server to launch the NetVanta UC Server Configuration Wizard.

b. When prompted to login, login as a user with NetVanta UC Server administrative privileges.

c. Complete the Gateways portion of the wizard. (Select Next, select None, then Next, then click Finish to
close the Gateway wizard).

d. Click Exit to close the NetVanta UC Server Configuration Wizard.
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Click the Configure UC Server button in the Preparing UC Server Installation dialog box.
Login as a user with NetVanta UC Server administrative privileges when prompted.

Click on the Change Service Account option and proceed to configure the service account.
Select the service account that was configured prior to the upgrade.

Click Close to exit the NetVanta UC Server Configuration Wizard.

Click Close to exit the Preparing UC Server Installation.

For ECS and BAS product variants, run the Post-Update.bat script file as follows:

a.
b.

Locate the command window opened in Step o.
Run the Post-Update.bat script, supplying any appropriate parameters relevant to your installation:

SyntaX:Post—Update.bat [/V | /2] [PhoneTypes Folder] [Backup Folder]

e Ifyour UC Server installation is not located at C: \Program Files\ADTRAN\NetVanta UC
Server)\, you must specify the location of the PhoneTypes system data folder as shown
below in the example.

e If backups were written to a location other than C: \Backup\PhoneTypes, then you must
specify the same backup folder as specified in Step o.

e The /2 option provides help on the script; the /v option provides more detailed output and

logging.

Example: Post-Update.bat "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\" "C:\Backup\PhoneTypes\"

When the script prompts you to continue, confirm the information displayed, type ¥, and then press
Enter.

Examine the output of the script to ensure it ran correctly. The output is placed in a file called
Post-Log.txt in the backup location, which defaults to C: \Backup\PhoneTypes.

When the script completes, it will indicate if any site-specific customizations have been made. Details of
the customizations will be output to a file called FileComparison. txt in the backup location. The
default backup location is C: \Backup\PhoneTypes.

The Post-Update script will only update all of the “attributes.xml” files for each phone type in use. It will
not modify any other files automatically. Please re-apply any necessary custom configuration to all other
files listed in “FileComparison.txt”. For any questions or concerns, please refer to phone vendor
documentation or contact ADTRAN support for guidance. Once any customizations have been re-
applied, restart the ADTRAN NetVanta UC Server Application Services service using the Services
administrative tool.

IMPORTANT NOTICE: For upgrades of ADTRAN phone family types, custom configurations
will be lost unless the following changes are made prior to running the Pre-Update.bat

e Locate the ADTRAN.original.zip on the release media

e  Extract to the following location: "C:\Program Files\ADTRAN\NetVanta UC
Server\Data\System\PhoneTypes\ADTRAN

e Runthe Pre-update and Post-update instructions as noted below
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IMPORTANT NOTICE: Since some phone firmware required for supporting new features in this
release have changed, the following phone family types including Polycom and snom'’s existing
user customized configuration files (.cfg) will be overwritten during an upgrade and cannot be
merged as a result of the post-update script execution as noted above. Custom configuration will
require user to edit the new .cfg files after the upgrade and associated phone firmware revision
update.

14. Updatethe RestartOverrides.cfgfile (locatedin..\NetVanta UC Server\Data\System\Recovery\)
according to the following conditions:

a.

If manual changes have been made to this file, then you must manually copy any entries from
RestartOverrides.cfg.original to RestartOverrides.cfgthatare not presentin the latter file.
If no manual changes were made to this file, then replace the contents of RestartOverrides.cfg with
the contents of RestartOverrides.cfg.original. Itis not necessary to restart the ADTRAN
NetVanta UC Server Application Services service. However, if the file has been appended to instead of
being replaced, then the application service must be restarted for the changes to take effect.

15. If Install Presence Components was selected in Step 9, you will be required to configure these components
at this time. Please consult the NetVanta Unified Communications Server Presence and Control Components
Guide for configuration documentation. If this is an upgrade from 4.2.X, 4.3.X, 4.4.X, 4.5.X 4.6.X or 5.X, then the
NetVanta UC Server Presence and Control Components could have already been configured.

16. For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please
refer to Section 3.7, Configuring Services, of the Installation Guide.

17. For ECS and BAS product variants, re-apply phone configurations to all phones in the system as follows:

a.

b.
C.
d

4.2.3

Open NetVanta UC Client and log in as a user with administrative privileges.

Click on the Administration navigation bar.

Click on the Phones folder in the Administration navigation bar.

In the contents pane, select all phones by clicking on the first phone, then pressing Shift-Ctrl-End on the
keyboard. All phones should now be selected.

Right click on one of the selected phones, and select Reload Configuration from the menu. This will
cause all phone configuration files to be regenerated and phones to reload their configuration data
(rebooting most phone types).

Cross-grading from CallAttendant Office Server 4.0.x/4.2.x to NetVanta UC Server

CAUTION: The existing version of CallAttendant Office must NOT be uninstalled prior to cross-
grading. The installation process requires that the existing implementation be available in order to
perform the upgrade correctly.

The following is a summary of the procedure for cross-grading your CallAttendant Office release 4.0.x/4.2.x
software, please consult the Installation Guide for detailed instructions on installing the NetVanta UC Server
component. If the CallAttendant Office software is currently below the 4.0 Software versions, you must first

upgrade to Release 4.0.x version.

This upgrade will take significantly longer as the NetVanta UC Server installation program will make a complete

copy of the data for the upgraded installation. For large installations where voice and fax messages are stored on

locally, it can take one to two hours to copy the data during the upgrade. Do not cancel the upgrade during this

process. As a result, this upgrade will require at least twice as much disk space as the Data folder occupies in order

to perform the upgrade.
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Prior to upgrading to release 4.0.x, do the following:

1.

Backup the CallAttendant Office using the instructions found in TNoy1 — Backup and Restore Procedures for
CallAttendant Office, available online at https://supportforums.adtran.com, to preserve the following data:

a. Users (greetings, services, announcements) e. Routing data

b. Port configuration f. Telephone data
c. Attendant data g. Gateway data
d. System configuration

CAUTION: Failure to backup the data according to these instructions and the Technical Note will
result in the inability to restore the system to the original configuration should the upgrade process
be unsuccessful or aborted. Always back the system up prior to upgrading.

Record the CallAttendant Office service account username and password. This can be done using the Services
Control Panel application. Select the CallAttendant Office service and record the username. The password
must already be known because it cannot be viewed in the Services Control Panel.

You must have an up-to-date license key to support the latest release of CallAttendant Office 4.0.x and
NetVanta UC Server (in some circumstances, you could receive two license keys that will be used to support
the upgrade). To obtain a new license key, please refer Section 3.3.3, Obtaining a New License Key.

Ensure that you enter the new license key in the CallAttendant Office administrator application (Help >
License Information) menu prior to upgrading the software.

CAUTION: If an existing PBX is being replaced with NetVanta Enterprise Communications Server,
please contact support@adtran.com for additional instructions.

To install NetVanta UC Server:

1.

Rename all of the configuration files in the . \Data\System by appending . o1d to the existing filename:

Example: C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the server computer (you will
need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade
Media.

b. Insertthe NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta
Unified Communications CD menu will appear.

If you plan on using NetVanta ucCompanion — Live Attendant, install or update the NetVanta UC Server

Presence and Control components at this time. Consult the NetVanta UC Server Presence and Control

Components Guide for installation documentation, which is provided on the distribution media.

Install the server applications to the NetVanta UC Server platform by clicking on the Install UC Server

buttons on the NetVanta UC Server installation screen and following the prompts on the subsequent screens

until finished.

For optimal performance, disable the Indexing Service provided by Windows. For detailed instructions, please

refer to Section 3.7, Configuring Services, of the Installation Guide.

Once the installation has completed, select the Configure UC Server button to run the Server Configuration

Wizard, but do not add anything if it has already been configured. From the set of options, at a minimum,

complete the following tasks:
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a. Enterthe NetVanta UC Server license key to enable SIP functionality.
b. Configure the Windows Network Integration and select from one of the following:
i. If the service account was previously configured for Local System account, you must create a
Windows account on the local machine. Operating the Application Services service on the Local
System account is no longer supported.
ii. If the service account was previously configured with a Windows Active Directory™ account, then
configure the Existing Service Account.
Open the Windows Services application and ensure that the ADTRAN NetVanta UC Server Application
Services service is set to start automatically. Note, you might have to refresh (F5) the services application in
order to get a current view of the status. From the Windows Services Applications, start the ADTRAN
NetVanta UC Server Application Services service if it is not already started.
Complete the remaining steps in the NetVanta UC Server Configuration Wizard. If appropriate, make any
additional configuration changes required, such as adding NetVanta Enterprise Communications Server as a
new communication system, adding new phone types or new gateways.

4.2.4 Cross-grading from CallAttendant Office Server 3.2.x to NetVanta UC Server (all editions)

NOTE: It is not possible to upgrade directly from 3.x to 4.2 and later releases (Refer to Section 4.2.1, Upgrade/Cross-
grade Matrix). An upgrade from CallAttendant Office 3.x to CallAttendant Office 4.0.x must be performed as an
intermediate step. Once this is complete, you can upgrade to the latest NetVanta UC Server 4.x release.

To upgrade 3.x to 4.0.x:

1.

Backup the CallAttendant Office using the instructions found in TNoyz — Backup and Restore Procedures for
CallAttendant Office, available online at https://supportforums.adtran.com, to preserve the following data:

a. Users (greetings, services, announcements) e. Routing data

b. Port configuration f. Telephone data
c. Attendant data g. Gateway data
d. System configuration

CAUTION: Failure to backup the data according to these instructions and the Technical Note will
result in the inability to restore the system to the original configuration should the upgrade process
be unsuccessful or aborted. Always back the system up prior to upgrading.

Stop the CallAttendant Office Service from the Windows Services application.

Rename the following files:

a. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\Announcements folder to Announcements.old

b. C:\Program Files\Objectworld\CallAttendant Office
Server\Data\System\DefinityPBXDefinition.cfgtoDefinityPBXDefinition.cfg.old

If the CallAttendant Office software was downloaded from the ADTRAN website, follow Step a. If the

CallAttendant Office CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the CallAttendant Office server
(you can create a CallAttendant Office folder). Start the installation by double clicking on
CAAutoRun.exe (the CallAttendant Office installation screen will appear). Preserve a copy of the
installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade Media.

b. Insert the CallAttendant Office CD-ROM. The Auto run application will start and the CallAttendant Office
installation screen will appear.

Install the Server applications to the CallAttendant Office platform by clicking on the Install CallAttendant

Office Server button on the CallAttendant Office installation screen and following the prompts on the

subsequent screens until finished. Do not choose to reboot the computer at this point.
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6. Open the Windows Services application and set the CallAttendant Office Service to start automatically.
NOTE: You might have to refresh (Fs) the Services application in order to get a current view of the status.

7. From the Windows Services applications, start the CallAttendant Office service.

8. Convert the system audio. If the software was upgraded from Release 3.1 or earlier, you must convert the
audio from the pre-existing 11 kHz-8bit audio format to the newly supported 8 kHz mu-law audio. Although
the CallAttendant Office server will change the audio format on-the-fly the conversion will introduce latency
in playing audio files or messages.

CAUTION: Ensure that you perform the audio conversion during the maintenance window —
typically, after normal business hours.

To perform the audio conversion:

1. From My Computer, navigate to the C: \Program Files\Objectworld\CallAttendant Office
Server\Bin directory.
2. Double-click on the ConvertAudio.exe application.

4.2.5 Upgrading Client Software

If anything other than a minor server upgrade has taken place, client software must be updated on end user
computers; only 5.1.x client software is supported with 5.1.x server software. Refer to Section 4.3, Installing or
Upgrading NetVanta UC Client Software, for installation options and procedures.

4.3 Installing or Upgrading NetVanta UC Client Software

This section documents manual installation procedures, and presents other techniques for automated client
deployment.

CAUTION: Only release 5.1.x NetVanta UC Client software is compatible with NetVanta UC Server
5.1.x software (the patch revision value 'x’ does not need to be identical). All incompatible clients
must be upgraded after the NetVanta UC Server has been upgraded.

4.3.1  Manual Installation or Upgrade Instructions

NOTE: The user installing NetVanta UC Client software MUST have administrative privileges on that desktop
computer.

1. If the NetVanta UC Server software was downloaded from the ADTRAN website, follow Step a. If the

NetVanta UC Server CD-ROM was shipped to you, go to Step b.

a. Unzip the contents of the file you downloaded to a temporary folder on the desktop computer (you will
need to provide a location and name for the folder). Start the installation by double clicking on
CAAutoRun.exe (the ADTRAN NetVanta Unified Communications CD Menu will appear). Preserve a
copy of the installation media accordingly. Refer to Section 3.1, Preserving Installation and Upgrade
Media.

b. Insertthe NetVanta UC Server CD-ROM. The Auto run application will start, and the ADTRAN NetVanta
Unified Communications CD menu will appear.

2. Install the client applications to the client computer by clicking on the Install Client button on the installation
screen and following the prompts on the subsequent screens.
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CAUTION: Installing NetVanta UC Client directly on the NetVanta UC Server platform is not
supported. Ensure that the client is installed on a separate platform meeting the minimum
requirements.

4.3.2  Other Techniques for Installing and Upgrading Client Software
Client software can be deployed using automated techniques including:

e GPO-based MSlinstallation. Refer to TN116 - Installing NetVanta UC Client Using GPO, available online at
https://supportforums.adtran.com, for more information on this option.

e GPO-based login scripts that invoke either SETUP . EXE or MSIEXEC . EXE with appropriate parameters.
Prerequisite components must have been previously installed successfully. Consult standard Microsoft
documentation for more information on those techniques.

5 Support, Documentation, and Training

5.1 Support

Self-service support material can be obtained from the ADTRAN website, http://www.adtran.com/support, and
from the ADTRAN Technical Support Knowledge Base, https://supportforums.adtran.com.

Information on product support services can be obtained from the ADTRAN website:
http://www.adtran.com/support.

5.2 Documentation

Product documentation and additional technical support material can be found on the ADTRAN website,
http://www.adtran.com/support, and in the ADTRAN Technical Support Knowledge Base,

https://supportforums.adtran.com.

5.3 Training

Information on current training programs and certifications can be found on the ADTRAN website:
http://www.adtran.com/training.

5.4 Product Downloads and Third-Party Drivers

Product downloads and third-party drivers and patches are available in the support area of the ADTRAN website:
http://www.adtran.com/support.
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6 Third-Party Interoperability

CAUTION: Some third-party drivers and applications may not support Windows Server 2008 and
derived platforms (SBS 2008, 2010). When using TAPI integrations, or other integrations requiring
the use of CTl drivers, please review driver documentation for those products BEFORE proceeding
with plans to use Windows Server 2008 as the server platform for those deployments.

Please consult information provided in TNog1 — UC Server Interoperable SIP Devices and Services, available online
at https://supportforums.adtran.com, for interoperability information related to:

e S|P telephone terminals
e SIP soft phones
e SIP paging speakers, amplifiers and related devices
e  SIP wireless terminals
e SIP gateways and application layer gateways (ALGs)
e |TSPs
Information on PBX integration and software applications is provided below in this document.

6.1 NetVanta UC Server with a PBX Integration

6.1.1  Supported Private Branch Exchanges (PBX)

NetVanta Unified Communications Server has the capability to connect to multiple traditional PBXs and IP PBXs
while simultaneously supporting SIP services . NetVanta UC Server can be deployed as a voicemail, unified
message server, database IVR platform, and fax server behind a traditional PBX while also simultaneously
supporting SIP telephony . This provides a useful transition strategy for companies looking to migrate to
VolIP but who still want to leverage their existing infrastructure. NetVanta UC Server users who employ a
traditional PBX for telephony can still take advantage of Active Directory™ integration for user management; the
telephony features will be managed through their PBX configuration interface.

NetVanta UC Server integrates with a wide variety of traditional PBX and IP PBXs using Dialogic 12000 and 2000
Media Gateways. The following PBXs are now supported using the Dialogic Media Gateway:

e  Alcatel Omni PCX 4400 e Nortel CS-1000

e Avaya Communications Manager e Nortel DMS 10

e Avaya Definity G3 e Nortel DMS 100

e Avayalegend e Nortel Meridian 1

e Avaya Merlin Magix e  Phillips Sopho

e Avaya Partner e Rolm (Siemens) 8ooo
e  Ericsson BusinessPhone e Rolm (Siemens) gooo
e Ericsson MDa1o e Rolm (Siemens) 9751
e Intecom PointSpan M688o e Siemens HiCom 150E
e Mitel 3300 e Siemens HiCom 300
e Mitel SX-2000 e Siemens HiPath 4000
o  Mitel SX-200D Family e Toshiba CTX

e NECNEAX2400
For more specific details on which PBX editions and interfaces are supported, consult the Dialogic Media Gateway
documentation available from Dialogic’s website: http://www.dialogic.com/support/helpweb/mg/integration.htm.
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NetVanta UC Server also integrates with the PBXs listed in the table below using one of the following techniques:

e Analog port integration with in-band tones using Dialogic® D/4PCIUF and D/120JST-LS Media Boards
¢ Digital set emulation using Dialogic® D/82JCT-U and D/42JCT-U PBX Integration Boards

e (Tllink/analog port integration using Dialogic® D/4PCIUF and D/120JST-LS Media Boards

e PBXVendor supplied Microsoft TAPI/WAVE Service Providers

PBX Minimum Technical Note | Integration Type Third-Party
Vendor/Model Software (TN) Reference Hardware/Software
Release Number (Recommended)
Avaya 1.0 and above TNo16 Digital set emulation: Dialogic 6.0 SU 266
Communications - 7434D emulation
Manager - 8434D emulation
- 7434ND emulation
Avaya Definity 6.3 and above TNoog Analog port using Dialogic 6.0 SU 266
(no CLID) mode codes; mode
code option is required
Avaya 4.0 and above TNoao Digital set emulation: Dialogic 6.0 SU 266
Definity/Multi- - 7434D emulation
Vantage - 8434D emulation
(with CLID) -7434ND (7.5 and
above)
Avaya IP Office 2.0 and above TNoa2 CTl link/analog port - IP 400 CTl link
using TAPI - IP 400 TAPI-WAVE
Dialogic 6.0 SU 229
Avaya Merlin 3.1and above Analog port using Dialogic 6.0 SU 229
Legend mode codes
Avaya Merlin 2.1 and above TNoo8 Analog port using Magix CTI link bundle
Magix mode codes Dialogic 6.0 SU 229
(with CLID)
Avaya Merlin 2.1 and above TNoo8 CTllink/analog port Dialogic 6.0 SU 229
Magix using mode codes
(no CLID) [TSAPI
Avaya Partner ACS | 3.0 and above Analog port using Dialogic 6.0 SU 229
mode codes
Cisco Call Manager | 4.2 TNo39 Cisco-supplied
Microsoft TAPI/WAVE
Service Provider
Mitel SX200 G1005/LW16 TNo11 Analog port using Dialogic 6.0 SU 229
(family) F41.0.2 enhanced in-band

DTMF tones
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PBX Minimum Technical Note | Integration Type Third-Party
Vendor/Model Software (TN) Reference Hardware/Software

Release Number (Recommended)
Mitel 3300 (IVR Any version that Analog port using Dialogic 6.0 SU 229
only) requires ONS in-band DTMF tones

voicemail support

Nortel Norstar 4.2 and above TNoo3 Digital set emulation: Dialogic 5.1.1 with
- M7324 set emulation | PTR.31016 **

Generic in-band PBX dependent Analog port using Dialogic 6.0 SU 229
in-band DTMF tones

** NetVanta UC Server ONLY supports Dialogic Release 5.1.1 software with PTR.31016 (LIBFAXMT.DLL) for
Norstar PBXs since the Do Not Disturb feature does not work with Dialogic Release 6.0 for Nortel Norstar PBX.

6.1.2 New Installation of Dialogic Software
To install Dialogic software on the new NetVanta UC Server:

1. Install the Dialogic System Software compatible with the PBX make and model.
a. Run SETUP.EXE from Windows Explorer.
i. When prompted to select features, select Core Runtime Package, select Next.

ii. When advised that the installation will install third-party software, select Yes. The installation will

detect and remove any existing Dialogic system software.
iii. The first stage of the installation will require a reboot. When prompted to restart the system,
select Yes.
2. Verify through the Windows Hardware Device Manager that all of the Dialogic cards reside in the Dialogic
Springware Devices section.

NOTE: If any of your cards appear to be improperly configured (for example, caution symbol or otherwise) then
you will have to update the driver.

a. Toupdate the driver:
i. Locate and configure the Dialogic card from Device Manager.
ii. Select the Driver tab and select Update Driver.
iii. Choose Search for suitable driver for my device (recommended), and click Next.
iv.  When the driver update locates the Dialogic Card, click Next.
b. Repeat Stepithrough Step iv for each Dialogic card that appears improperly installed or configured.

—DCM. DCM will detect any Dialogic hardware installed on the machine hosting NetVanta UC Server
software.
a. Ensure that the board settings match your PBX type. (The default configuration is Nortel Norstar.)

Run Dialogic Configuration Manager (Start > Programs > Dialogic System Release > Configuration Manager

b. Fordigital set emulation, open each card and ensure the MISC tab > PBXSwitch parameter is configured

according to your integration.
c. Referto the relevant configuration guide
4. Configure the Dialogic service to start automatically; Select Settings > System Device Autostart to Start

System. It is normal to encounter the error message Failed to set the Device Autostart setting. Requested

data not found in NCM data storage.
5. Proceed with NetVanta UC Server installation instructions.
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6. Verify the Dialogic board ordering by running NetVanta UC Client as an administrator and call each port. If
the ports are not answering in the correct order, switch the Dialogic cables on the back of the machine
hosting NetVanta UC Server software.

6.1.3 Toupgrade Dialogic software on existing NetVanta UC Server (if required)

Once you have determined that the Dialogic software version needs to be upgraded then perform the following
steps:

1. Remove existing Dialogic system software.

a. Stop the existing NetVanta UC Server and Dialogic services.

b. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel >
Administrative Tools > Services).

i. Stop the service labeled ADTRAN NetVanta UC Server Application Services and change the
service Startup type from Automatic to Manual.

ii. Stop the service labeled Dialogic System Service.

c. Remove the Dialogic System Software.

i. Locate the Add/Remove Programs from the Windows Control Panel (Start > Settings > Control Panel

> Add/Remove Programs).
ii. Select and Remove the Dialogic software.
d. Reboot the system as indicated.

2. Inrareinstances, you might need to run a Dialogic utility to clean up the old Dialogic Release 5.1.1 installation
files, directories, and registry settings. This batch file can be located in \cleanup\dlgc rel clean.batin
the Dialogic installation directory. This will be apparent if the Dialogic DCM — configuration management
application is not installed.

3. Install the Dialogic System Software.

a. Follow the procedure in the previous section (New Installation of Dialogic Software) to install the required
version of Dialogic applicable to your PBX.

4. Launch the Microsoft Windows Service control application (Start > Settings > Control Panel > Administrative
Tools > Services).

a. Setthe Startup type to Automatic for the service labeled ADTRAN NetVanta UC Server Application
Services.

6.2 Software Product Interoperability

The following other software products have been tested and are known to work with NetVanta UC Server:

Vendor Interoperability Product/Service Software Version
Level
Research In Motion | Interoperable BlackBerry Enterprise Server 4.1 0r newer
(RIM) for Microsoft Exchange
BlackBerry Handheld Devices 4.2.1rev 163, 4.2.2 Or newer
PhoneTag Interoperable PhoneTag nfa
(formerly SimulScribe)
Google Interoperable Google Mail (Gmail) n/a
using stunnel (SSL proxy) stunnel 4.24 or newer
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7 Known Software Limitations

The following limitations are known in this NetVanta UC Server release:

Tracking # ISSUE Workaround

UCS-109  ucCompanion settings are not being retained on None
Upgrade from release 4.6.3

UCS-140  Must uninstall existing server Presence and Control = For manual upgrades, run the following
Components prior to running the 5.x as upgrade switch with .misi file:
procedure REINSTALL=ALL REINSTALLMODE=vomus

UCS-252  The ucCompanion DesktopClient will no longer be  None- Windows issue
pinned to the start menu after an upgrade.

UCS-370  Self-healing not supported - UC forms preview You must install the client under the logged
pane registry setting in account.

UCS-343  ucCompanion may crash following "Run As" dialog Do not “Run as” Administrator — change UAC
prompt settings or "Run as” default accordingly.

UCS-271 By default, the server only accepts connections Refer to the installation guide for more
from the same version of client on the 5.x release details.

UCS-197  ucCompanion client will not be able to connectto  Refer to the installation guide for more
the server from an untrusted client workstation by  details.
default

UCS-665  Ina Refresh INVITE, UC receives a 200 with SDP Modify the SQL "useragentconfig" table
but responds to the 71200 with an ACK without SDP. entry for id "B2BUA" to increase the refresh
The call drops. timer

UCS-656  NetVanta UC Management Shell launches with Set Get-ExecutionPolicy to the appropriate
script execution error policy settings via PowerShell

UCS-655 PBA user that has shared admin service action None
cannot execute take message operation

UCS-644  Disconnecting from a conference call (after Call the Recording service first, and then call
conferencing in a call recording service) fails to the conference bridge.
update presence

UCS-399  Unanswered queue call from UC (where queue Create a virtual user that forwards the
provides ringback only) unexpectedly continues incoming call to the queue extension and
ringing caller covers to an overflow extension

UCS-585 ECS Server losing its network binding occasionally  Ensure only one network adaptor is
when running on VMWare virtual platform configured in VM for ECS

UCS-542 MOH stops playing after call held for 15 minutes None — as designed

UCS_404 Service editor does not allow invalid service Correct the service through the editor

imports - auto corrections may leave orphaned
elements. When executing these services, only the
first element will get executed.

33




NetVanta Unified Communications

Tracking # ISSUE Workaround

UCS-615  ucCompanion font issues with WPF generates Known Microsoft issue with WPF may require
exception font re-installation or registry correction

UCS-858  Polycom 301, 501, 601 with park zone configured,  Select the blind softkey and then the number
supervised and blind transfers will fail to complete. softkey on the Polycom screen to complete

call.

UCS-710  Application Service unexpectedly restarts during Windows Updates should be applied only
system updates during a maintenance window

UCS-630  Inatwo server scenario DR (Primary and None —as designed
Secondary ECS) call forward does not function
when primary server is down.

UCS-699  When an identity specified in the supervised Ensure the target identity is valid and
transfer element is valid but is not registered, the registered
element does not attempt to try transferring to the
next identity in the list

UCS-923  Connection loss on local server causing Restart the application server service to re-
ucCompanion connected to remote (federated) connect the federate server.
server to shut down the connection

Ucs-888  ucCompanion popup toast unexpectedly re- None — as designed
appears every 60 seconds after copy/paste
operation

UCS-980  T38Faxes from UC server via Sonus SIP Trunk Fails  None- not supported as this time

UCS-413  Group identity with lengthy list of numbers fails Keep group identity list to less than 256
edit silently members

UCS-444  UC Client/softphone Select server dialog not None
remembering last server selected

UCS-457  Offering from federated identity displays Caller ID  None
unexpectedly with the IP appended to the identity

UCS-486  Adding/removal of larger numbers to/from the Reduce number of additions or removals at
group(s) hangs ucCompanion for a while (Not any one time
Responding)

UCS-508  Admin client server pane no longer displaying Shutdown UC Server application then delete
trusted UC servers after shutdown the remote server objects within the data.

UCS-493  Federated search timeout setting "trusted-server-  Add the entry to the .xml file. If the setting is
search-timeout" missing from the not present, the default (2 secs.) is used by
GlobalPropertyStore.xml file default

UCS-559  Exchange server version warning appears in the
swlogs but not in the Ul of the SCW

UCS-573 Multi-selection on items in groups only works with  None
Ctrl+Select

UCS-764  Parkfailover, when configured with invalid Ensure that the failover identity is valid.
identity, never sends reminder (even to park
initiator)

UCS-762  Pickup operation during failover fails to find call Repeat pickup with multiple attempts

parked at the location in which is had been parked
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Tracking # ISSUE Workaround

UCS-704  Some (but not all) BLF's or Park zone buttons are Restart the Phone for correction
removed from Polycom (with sidecar) when app
service restarts)

UCS-562  Intermittently fails to delete the Exchange server Repeat deletion after application server
object from the admin client (Communication error service via services.msc
results)

For more information on other “Known software limitations” please refer to the associated release notes for
the specific release (e.g. 4.6.x or 5.0.x/5.1.x releases)
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